
Instructions to Computer labs 1- 6 (C1-C6) in AG2800 (2016) 
 
C1-C2: Learning to use SimaPro 
C3-C6: Own project modelling 
 
We will meet at six occasions in the computer lab. During C1-C2 you will run the SimaPro 
demo, some exercises, and the tutorial to get acquainted with the software. Later on you will 
work on your project models. 
 
The good way to learn to use SimaPro is learning by doing. We will not actively teach you 
how to use SimaPro, you will learn by exploring the software on your own, and we will 
support you in this. The Demo and Tutorial give a good introduction, and there are also 
instructions for a small test model for you to build and run in SimaPro. 
 
Manuals 
Manuals are available in the software under the Help menu, and are posted on the course web 
in Canvas. 
 
Groups 

- During C1-C2, work in pairs from your group on the demo, tutorial, and exercises. 
- During C3-C6, work with your project together with all group members.  

 
Getting started 
 

1. Start: Start SimaPro from the Start menu on your computer. 
 

2. Server and database: If the database server does not appear automatically, you need 
to open the database. From the “File” menu, choose “Open SimaPro database”, a 
dialogue box will open. 

a. Select server fms-edu.infra.kth.se 
b. Select location “HT2016_Pro” 
c. Select database “Professional” 
d. Click “Open” 

 
3. If SimaPro starts and another database is opened automatically (read at the top of the 

screen what database is open), then select “File/Open database”, and then follow the 
instructions above (2a – 2d). Ask your teacher if you are not sure how to. 
 

4. Log in: Log in by selecting the correct user (you will be assigned one by your 
teacher). Password is the same as the user name. 
 

5. Language: If SimaPro opens in Swedish, change language to English by clicking on 
the upper panel: Verktyg/Språk/English. You must restart SimaPro to make the 
language change in all parts of Simapro. 
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1 SimaPro demo 
 

1. After opening the correct database according to the instructions above, open 
project “Introduction to SimaPro” 
 

2. From the LCA Explorer, section “Wizards”, choose “Guided tour (with coffee)” 
 

3. Work your way very thoroughly through the demo and make sure that you 
understand what you see and read. Do not rush - there is a lot to explore!!! 

 
4. Along the way, discuss with your group the questions listed below. These 

highlight important LCA terms and features of SimaPro. 
 

5. Take notes of answers to questions denoted Q1, Q2, etc. Ask your teacher 
whenever you have questions! 

 
6. After completing the demo, join another pair of students to compare your answers. 

If your answers do not agree, go back to this step in the demo to find the right 
answer. 

 
 
Questions to SimaPro Demo “Guided tour (with coffee)” 
 
Step 1  

- Read the instructions for the demo.  
 
Step 2 

- Choose “Analyse a product”. 

Steps 3-5 
- Q1: What do assemblies and subassemblies in SimaPro represent? 
- Q2: What is a process network? 
- Q3: What subassemblies are needed to construct the coffee machine? 
- Q4: What processes and materials are needed to manufacture these parts? 
- Use the slider navigator. Find out where to turn it on or off. 
- Shift between views of the process network (“Product stages only”, ”All” etc.) by 

using the roll-down menu. 

Steps 6-7 
- Q5: What is presented in the LCI results/inventory table? 
- Q6: What is a compartment? 
- Q7: What compartments are included in this inventory? 
- Sort the emissions of substances in alphabetical order by clicking the column heading. 
- Sort the emissions according to what compartment they are emitted to. 
- Shift between mixed units and default units by ticking the box “default units”. 
- Include/exclude long term emissions by ticking the box “Exclude long-term” (you 

might not see much difference in this case). 
- Q8: How much biogenic carbon dioxide (CO2) and fossil CO2 is emitted to air by 

producing the coffee pot? In total, and per subassembly of the coffee machine? 



- Q9: Carbon dioxide is also listed in the compartment “Raw” (raw material). When do 
you think CO2 can be a raw material? 

Steps 8-9 
- Q10: The impact assessment step in LCA includes characterisation. What is it and 

what is its purpose? 
- Q11: What environmental impact categories are included in the method ReCiPe? 
- Q12: Each bar (impact category) in the chart has the same height. How come? 
- Q13: What part (subassembly) of the coffee machine is the most important contributor 

to climate change, and how large is this contribution in absolute numbers (switch 
between chart and table)? 

- Q14: Include/exclude long term emissions by ticking the box “Exclude long-term”. 
What happens and why? 

Steps 10-11 
- Q15: What is normalisation and what is its purpose? 
- Q16: What is the reference value to which impacts are normalised in the ReCiPe 

method?  
- Shift between areas of protection (Human health, Ecosystems, Resources) and impact 

categories by ticking the box “Per impact category”. 
- Q17: In what impact category does the coffee machine have the largest relative 

contribution according to the normalisation in ReCiPe method? 
- Q18: What part of the coffee machine has the largest contribution to this impact 

category, and what is the value of its normalised contribution (switch between chart 
and table). 

Steps 12-13 
- Q19: What is weighting, and what is its purpose? 
- Q20: Why do you think weighting should not be applied in comparative LCAs 

displayed to the public, according to ISO standard? 
- Q21: What unit is used when measuring weighted impacts? What do you think it 

represents? 
- Q22: Based on the weighted results, what is the most serious impact category for the 

coffee machine? 
- Q23: What part of the coffee machine has the largest contribution to this impact 

category, and how large is its weighted contribution? 

Steps 14-15 
- Q24: What is the single-score? 
- Q25: What subassembly has the highest impact, according to the single score? 
- Q26: What is the most important impact category of this subassembly, according to 

the single score (switch between chart and table)? 

Steps 16-17 
- Find out how to adjust the cut-off level of processes shown on the screen. 
- Q25: How many process/materials are displayed for single score results at 6% and 

0.5% cut-off, respectively? 
- Find out how to display different results in the network. Find the following: 

 Single score 
 Inventory/airborne emissions/carbon dioxide, fossil 



 Characterization/Metal depletion 
- Q26: What processes/materials contribute more than 3% to total fossil carbon 

emissions? 
- Try the buttons “Show cumulated indicators”, “Show indicator as percentage”, “Show 

flow indicator in line width”. Make sure you understand how these affect the way the 
results are displayed. 

Step 18 
- There are many more impact assessment methods than ReCiPe, the one you just 

worked with. At this point you do not need to try these. In your projects you will use 
ReCiPe.  

Step 19 
- Choose “See life cycle for model Sima”. 

Steps 20-21 
- Q27: What is the difference between a product (assembly) and a life cycle in 

SimaPro? 
- Q28: What is a functional unit? Why is it important in LCA to be very specific when 

defining the functional unit? 
 
Step 22-23 

- Find the assembly (coffee machine) that you studied previously among the different 
stages of the coffee machine life cycle. 

- Q29: What other assemblies, processes and life cycles have been added to model the 
complete life cycle of the coffee machine? 

- Try the different buttons and keys that you used previously to make sure you 
remember how to use them. 

Step 24-25 
- You have already seen a similar chart for the coffee machine assembly. Note that, 

while you could then identify the subassemblies and processes needed to build the 
coffee machine, this time (when analysing the entire life cycle) only the total impact of 
the main assembly is displayed.  

- Q30: What colour represents the main assembly in the chart? 
- Instead of subassemblies, additional life cycle stages are displayed in this chart. See 

the difference? Hence, if you want to study the assembly and its subassemblies in 
detail, you need to run an analysis of only the assembly model. 

- Q31: What parts of the chart represents the use phase of the coffee machine? 
- Shift between table/chart, and make sure that you understand what you see. 
- Shift between characterisation/normalisation/weighting/single score, and make sure 

that you understand what you see. Recall what all these things mean! 
- Q33: What is the contribution (in % and total amounts) of the use phase of the coffee 

machine to the climate change impact category? 

Step 26 
- You can skip the other impact assessment methods. 

Step 27 
- Choose “Continue the tour: Compare products”. 



Step 28 
- Q34: Why do you think that ISO requires peer review for comparative LCAs 

displayed to the public? And why is weighting not allowed? 
- Q35: Considering what you learned about the life cycle of the coffee machine “Sima”, 

what do you think will be the effect of the thermos jug in model “Pro”? 
 
Steps 29-30 

- What are the assemblies, processes and additional life cycles of the life cycle of 
“Pro”? Turn off the cut-off to see all of them. 

- Q36: Why is the contribution of “Disposal scenario” negative? 
- Q37: Why are some arrows green? 

Step 31-32 
- Shift between characterisation/normalisation/weighting/single score. Recall what each 

of these different ways of presenting results represent. 
- Look at “characterisation”. What does 100% mean in this chart? 
- Shift between table/chart for “characterisation”. What is the difference in the results 

displayed in chart vs. table? 
- Q38: The impact of the Disposal scenario is negative for most impact categories (you 

can see this in characterisation, normalisation, weighting, and single score). Why? 

Steps 33-34 
- In this chart, each bar represents one of the two coffee machine models. 
- Try out all different ways of displaying results that you have used before. Recall what 

they mean and how they can be used. 
- Q39: Why is the impact from production of Sima lower than that of Pro for most 

impact categories? 

Steps 35-36 
- Try out all different ways of displaying results that you have used before. Recall what 

they mean and how they can be used. 
- Q40: Why does Sima have higher impact over the entire life cycle, although Pro had 

lower impact from production? 

Steps 37-41 
- Q41: What is a sensitivity analysis? When is it important to make a sensitivity 

analysis? 
- Q42: Sensitivity analyses were done for the assumed life time, the assumed take back 

system, and the intensity of use. Can you think of any other important assumption to 
make a sensitivity analysis of? 

Step 42 
- You can skip the other impact assessment methods. 

Step 43 
- End the guided tour 

 
 
 



2 Create a simple SimaPro model 
This exercise is to help you understand how to start building your own models in SimaPro. 
You will create a simple model comparing the life cycles of two complete nonsense products.  
 

1. Create new project: Start by creating a new project. From the File menu, choose 
“New project”. Give you project a name. 

 
2. Select libraries (library = database) that you want to have accesses to from the 

database from the SimaPro Explorer menu “Goal and scope/Libraries”. For this 
exercise, select only these: 

 
• “Ecoinvent 3 – allocation, default – system” 
• “Ecoinvent 3 – allocation, default – unit” 
• “Methods” 

 
3. Select impact assessment method. In the SimaPro Explorer menu, go to “Impact 

assessment/Methods” and select ReCiPe Midpoint (H). This is the impact assessment 
method that you will use in your course projects. Click “Set as default”.  
 

4. Create new assemblies by selecting from the Explorer menu “Inventory/Product 
stages/Assembly/Others” and click “New” (button to the right). 
 

5. Create a new life cycle by selecting from the Explorer menu “Product stages/Life 
cycle/Others” and click “New” (button to the right). 
 

6. Enter data: Assemblies and Life cycles have two tabs/sheets for data entry. Enter 
your model data in the sheet “Input/output”. Do not use the sheet “Parameters”. 

 
7. Search the database for materials and processes, using “Find” (from the menu 

Edit/Find), or by browsing the list of Processes. 
 

8. Link processes, materials, and sub-assemblies to assemblies by double-clicking the 
empty fields in the input/output sheet of an assembly. This opens up a link to the 
database. Life cycles are constructed in the same manner. 

 
 



Product A: Create assembly and life cycle 
 
Build an assembly representing product A; call it “Product A” 
 
Materials included in the product 

- 2 kg of  “Core board {RER}| production | Alloc Def, S”1 
- 10 kg of  “Aluminium, primary, ingot{UN-EUROPE}| production | Alloc Def, S” 

 
Process energy in manufacturing 

- 10 kWh “Electricity, medium voltage {SE}| market for | Alloc Def, S” 
 
 
Build a life cycle for product A; call it “Life A” 
 
Assemblies included in the life cycle 

- 1 p (piece) of “Product A” 
 

Processes included in the life cycle 
- 100 tkm (tonne*km) “Transport, freight, lorry 16-32 metric ton, EURO6 {GLO}| 

market for | Alloc Def, S” 
 
Waste scenario included in the life cycle 

- “Municipal solid waste (waste scenario) {SE}| treatment of municipal solid waste, 
incineration | Alloc Def, S” 
 
 

Product B: Create assembly and life cycle 
 
Build an assembly representing product B; call it “Product B” 
 
Materials included in the product  

- 5 kg of “Flat glass, coated {GLO}| market for | Alloc Def, S” 
- 2 kg of “Aluminium, primary, ingot{UN-EUROPE}| production | Alloc Def, S” 

 
Process energy in manufacturing 

- 10 kWh “Electricity, medium voltage {DE}| market for | Alloc Def, S” 
 
 

                                                 
1 Core board = name of material  
RER = international shortcut for Europe, detailed list of geographies available at: 
http://www.ecoinvent.org/home.html 
production = indicates that the dataset includes only production, not market (e.g. transportation to consumer) 
Alloc Def (Allocation Default) = indicates what Ecoinvent library, based on what methodological approach, the 
dataset comes from (in this case default allocation method, attributional approach). There are others. 
S (System process) = indicates that this dataset includes aggregated up-stream impacts, as opposed to “Unit 
process” (U), including the same up-stream impact but disaggregated so that one can view the entire process tree. 



Build a life cycle for product B; call it “Life B” 
 
Assemblies included in the life cycle 

- 1 p of “Product B” 
 

Processes included in the life cycle 
 

- 100 tkm “Transport, freight train {CN}| market for | Alloc Def, S” 
 
Waste scenario included in the life cycle 

- “Municipal solid waste (waste scenario) {SE}| treatment of municipal solid waste, 
incineration | Alloc Def, S” 

 
 
2.1 Analyse product A and product B separately, one at a time 

- Select “Life A”, click the button “Network” located in the tool bar. Alternatively, 
select “Network” from the roll-down menu “Calculate”.  

- Play around to understand what you see, for instance the different ways of looking at 
the results that you learned when running the coffee machine wizard. 

- Jump back to the explorer screen by clicking “LCA Explorer” in the tool bar. 
Alternatively, select “LCA explorer” from the roll-down menu “Window”. 

- Then do the same thing all over again with “Life B”. 
 
2.2 Compare A and B 
Select the life cycles of both Life A and Life B by holding down the shift key. Click the 
button “Compare” (“Network” is not possible to use when you make comparisons.). Choose 
an impact assessment method. Play around to understand what you see. 
 
 
 
 
 
 
 
 
 
 



3 Run the SimaPro tutorial 
Spend a couple of hours to work through the Tutorial (open project “Tutorial with wood 
example”). 
 

- Open the Tutorial manual, available under Help. 
- Follow the instructions in the manual. 
 
- Lesson 1: In-depth explanation of the coffee machine demo 
- Lesson 2A – 2D: Learn how to create projects in SimaPro. If you work through this 

part carefully, you will learn basically all you ned to know to use SimaPro in your 
projects! 

- Lessons 2E - 6: Skip. 
 

NOTE: The tutorial instructions are for the advanced (researcher) versions of SimaPro, 
some features of which are not available in the Classroom version that you are using. 
For instance the DQI requirements referred to in Lesson 1 part 2.4. 
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